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Appendix 1. List of Computer Files in the \LUSE Directory

All files that should be on the hard disk of your computer after a complete installation of The
Land Use Database are listed below (the compressed files from which they were extracted
are underlined). The .DBF files are database file in dBase-IIlI" format containing numbers
and codes. The .DBT files are database files containing texts (memao's) of the free text

windows.

In the LUSE directory:

ARJ.EXE :
PROG.ARJ :

CONFIG.ARJ :
LUTBASE.ARJ :
LBCFG.ARJ :

ARJ.EXE
LUSE.BAT
LBHELP.DBF
CO1STD.COL
CONFIG.EXE
LUTBASE.EXE
LB.CFG

In the LUSE\DATA directory:

DATA.ARJ :

CAQUAN.DBF
INPUT.DBF
LABINPUT.DBF
LUSENAME.DBF
QUERY.DBF
PARCEL.DBT
SEQUENCE.DBT

In the LUSE\GLOSSARY directory:

GLOSSARY.ARJ :

Note

DATASET.DBF

LUSE2.BAT
LBHELP.HLP
CO2STD.COL

IMPLEM.DBF
PARCEL.DBF
LUSEATTR.DBF
OPEROBS.DBF
SEQUENCE.DBF
QUERY.DBT
CHECK.1

GLOSSARY.DBF

MAIN.EXE
BWSTD.COL
LCD.COL

INFRA.DBF
QUESTION.DBF
LUSECA.DBF
PRODUCE.DBF
OPEROBS.DBT
QUESTION.DBT
CHECK.2

GLOSHELP.DBF

After installation, in the various directories, also *.CDX files may be present. They
represent 'index’ files containing index keys that establish the links between records in

different database files.

When certain *.CDX files are absent, the software will

automatically create new ones during start-up procedures. Then for each *.DBF file one

* CDX file must exist.
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Appendix 2. Codes in Colour Settings File |

The Land Use Database uses a *.COL file containing preferences about "screen-mode" and
"colours”. A number of files is supplied in the C:\LUSE directory (see Section 6.2.1),
containing settings for a monochrome, colour and LCD monitors. These files are provided
with default settings, but you may edit them or create new ones. You can use any ASCII-
based text editor to modify them, according to the following rules:

1. |If the first character on a line is an asterisk (*), or the line is empty, then the line is
skipped by the program.

2. All other lines must consist of a setting, the equal-sign (=), and a constant. The lines
may be in upper case, lower case, or mixed case. Between the setting, the equal-sign
and the constant, spaces and/or tab characters may be inserted.

3. Defining colours. The following settings are available:

cBox=normal,enhanced
The colour of the edit screens. Normal applies to the frames, enhanced applies to
the titles.

cSays=normal,enhanced
The colour of regular text. Normal applies to plain text, enhanced applies to some
specific text.

cFields=normal,enhanced
The colour of the fields of edit screens. Normal applies to the non-current fields,
enhanced to the current field.

cMenus=normal,enhanced
The colour of the picklists. Normal applies to the non-highlighted items, enhanced
to the highlighted item.

cMessage=normal
The colour of the messages displayed in the information bar.

cError=normal
The colour of the message <Press Return> when an error occurred.

cintro=normal, enhanced
The colour of the screens displayed before any Main Menu of a module.

Both normal and enhanced consist of a foreground and a background colour, separated
by a slash (/). If you use "enhanced", you must type the comma (,), even if you want to
omit "normal". The available colours are listed in the below table:
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Colour monitor Code Monochrome monitor

Black N, Space Black

Blue B Underline

Green G White

Cyan BG White

Red R White

Magenta RB White

Brown GR White

White W White

Gray N+ Black

Bright Blue B+ Bright Underline

Bright Green G+ Bright White

Bright Cyan BG+ Bright White

Bright Red R+ Bright White

Bright Magenta RB+ Bright White

Yellow GR+ Bright White

Bright White W+ Bright White

Black U Underline

Inverse Video I Inverse Video

Blank X Blank

Note 1: In addition, every foreground colour may be followed by an asterisk (*), to
denote that the text should be blinking.

Note 2: It is not recommended to use the colour Inverse Video (I), because inverse

video is based on the last used colour, which could have been from a
different setting.

Any invalid line in the file is skipped. If an error occurres, a message will be displayed for
that line (at program start). If the appropriate file is not found, the program will use some
default colours.

Below follows an example of the provided file for monochrome screens, B&W.COL:

* BWSTD.COL (for Monochrome screens)

cBox =  W/M,N/W
cSays =  W/N,W+/N
cFields = N/W,W+/B
cMenus =  W/N,W+/N
cMessage = N/W
cError = N*W

clntro =  W/N,W/IN




Appendix 3.

List of All Fields and Their Attributes

Below, all fields of Land Use Data and Land Use Classes are listed per data entry
screen (i.e. file), in the order in which they appear in the screens. The field names,
links to glossary trees and options to select the field and pre-select glossary items
in the data entry filter are printed (Filter). The Identifier fields marked with a =« can
only be used for the definition of rules and output fields in the Query Module.

Type of Field

)
)

lihked to an apriori LU class

>q = linked to a glossary tree
»a =

» f = linked to afixed picklist
-n

= numbe field
- d = date field
- 1. latitude/longitude field
- ¢ = code field
-f. free text fied

Filter Options

Fix = field is dways included

Y/N = field can be selected

» = glossary items can be pre-selected
PE . the previous entry can be printed

File Name& Field Name Type of Fidd Link to Glossary Tree Filter
Dataset Identifications (Section 6.4.2)

. A Unique Dataset ID -n

Adminidrative Area >g Adminidrative Areas Fix »
Project > Projects Fix »
Dataset Number -n Fix
Dataset Type » f Fix
Enumeration Date -d YN
Enumerator's Name - f Y/N PE
Respondent's Name - f Y/N PE
Holder's Name - f YN PE
Holding Location - Latitude (S or y) -1 YIN
Holding Location - Longitude (*, or x) -1 YIN
Holding Location - Ellipsoid/Spheroid YIN
Holding Location - UTM Zone -n YIN
Holding Location - UTM Northing -n YIN
Holding Location - UTH Eadting -n YIN
Holding Size -n YIN

- Unit >Q Data Units Fix »
- Info Source > Inf O Sources Y/N »
Comments - YN

~ Continued



File Name { Field Name Type of Field Link to Glossary Tree Filter
Site |dentifications (Section 6.5.2)

¢ A Unique Site-ID -n

Plot Aggregation >f Fix
Mapping Unit-ID -C Y/N PE
- Comp. /Element-ID YN

- Hap Comnents 1 YIN
Ste Name - f YIN
Cadastral Number -Nn YIN
Tenancy Arrangement > Tenancy arrangement YIN»
Parcel Size -n YIN

- Unit >( Data Units Fix »
- Info Source g Info Sources YIN»
Distance to Holding -n YIN

- Unit > Data Units Fix »
- Info Source > Inf O Sources YIN»
Comments - YIN
Land Use Svstem Descriptions (Section 6.6.2)

. A Unique LUS Description ID -Nn

Plot Location - Latitude ($ or y) -1 YIN
Plot Location - Longitude (* or x) -1 YIN
Plot Location - Ellipsoid/Spheroid YIN
Plot Location - UTM Zone -n YIN
Plot Location - Northing -n YIN
Plot Location - Easting -n YIN
Plot Size -n YIN

- Unit >q Data Units Fix »
- Info Source > Info Sources YIN »
- Boundaries » Fix
Infrastructure * Fix
Soil Sample-ID - C YIN
Oper.Seq. Period -d YN
A-Priori LU Class »a Land Use Classes Fix »
- Purposes { Quant. Fix
Comments - f YIN
Infrastructure (Section 6.6.3)

. A Unique Infrastructure -n

Infrastructure >q Infrastructures YIN >
Quantity -n YIN

- Unit > g Data Units Fix »
- Info Source >q Inf 0 Sources YIN »

Continued



File Name & Field Name Type of Field Link to Glossary Tree Filter
Land Use Purposes and Ouantities (Section 6.6.4)

I'A Unique LU Purpose ID -n

Species/Service >( Species/Services Fix »
Product/Benefit > ProductyBenefityMaterids Fix »
Quantity -N Fix

- Unit >g Data Units Fix »
- Info Source >g Info Sources Y/IN >
Operations (Section 6.7.2)

A Unique Operation ID -n

Operation >g Operation Names Fix »
- Species involved >( Species/Services Fix

% of Plot involved -N YN
Operation Period -d YIN
Periodicity >f YN

- Description - f YIN
Operation Duration -n YIN

- Unit >g Data Units Fix »
- Info Source >( Inf 0 Sources YN »
Task Time -n YIN

- Unit >q Data Units Fix »
- Info Source >g Inf 0 Sources YIN »
Labour Inputs * Fix
Materid Inputs ' Fix
Implements Used * YIN
Main Power Source >0 Power Sources Fix >
Products/Benefits * Fix
Comments - f YIN
Labour Inputs (Section 6.7.3)

2 A Unique Labour Input ID -n

Gender & Age Class >q Gender § Age Classes Fix »
Skill >( Skills YIN »
No. of Persons -Nn YIN

- Info Source > Info Sources YIN >
Task Time -n YIN

- Unit >( Data Units Fix »
- Info Source >g Inf 0 Sources YN »
Labour Origin >g Labour Origins YIN »

Continued



File Name& Field Name Type of Fied Link to Glossary Tree Filter

Material Inputs (Section 6.7.4)

i A Unique Materia Input 1D -N

Materia Input >g Materid Inputs Fix »
Qudity Class > Quality Classes YIN »
Quantity -Nn YIN

- Unit >g Data Units Fix »
- Info Source >g Inf 0 Sources YIN »
[nput Origin >g Materid Input Origins YIN »
Implements Used (Section 6.7.5)

. A Unique Implement ID -n

Implement >g Implements Y/'N »
- Implement Species >g Species/Services Fix
Quality Class >q Quality Class Y/IN »
Number used -Nn YN

- Info Source >g Info Sources YIN»
Implement Origin >g Implement Origins YIN »

Obtained Products/Benef its (Section 6.7.6)

. A Unique Product/Benefit 1D -n

Species/Service >g Species/Services Fix
Product/Benefit >Q Products/BenefitsMaterials  Fix
Qudity Class >( Quaity Classes Y/IN »
Quantity -n YIN

- Unit >g Data Units Fix »
- Info Source >g Inf O Sources Y/N »
Product Dedtination >( Product Destinations YIN >
- A-Priori LU Class »a A-Priori Land Use Classes Fix
Observations

. A Unique Observation ID -n

Observation Name >g Observation Names Fix »
- Species involved >g Species/Services Fix
Sample-ID YIN
Observation Period 1 YIN
Relocated Materid » g Products/BenefitsMateridls Y/N 7
- Origin/Destination >Q Materid Relocations YN
Observed Quantity -Nn YN

- Unit >( Data Units Fix »
- Info Source >g Info Sources Y/N »
Implements  Used > YIN
Production Increase -n YIN

- Info Source > Inf O Sources Y/N »
Comments —% YIN

. Continued



File Name & Field Name Type of Fied Link to Glossary Tree Filter

A-Priori Land Use Classif ication Systems /| A-Priori Land Use Classes (Sections 6.8.2 / 6.8.4)

. A Unique A-Priori LU ClassID -n
Code Fix
Name / A-Priori Land Use Class 1; Fix

Land Use Purpose Classifiers (Section 6.8.4)

. A Unique LU Purpose Classfier ID -n
Specied/Service > Specied/Services Fix
Product/Benefit > ProductsBenefitdMaterials  Fix

Other Classifiers (Section 6.8.4)

¢ A Unique Classifier ID -n
Operation Sequence Classifiers “4 Classfiers: Oper .Sequence YN »
Context Classifiers > Classifiers: Context YIN »
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Appendix 4. Coordinates

Two types of coordinate systems can be used to specify a location in The Land Use
Database: geographical coordinates and UTM projections. The program can transform
geographical coordinates to UTM projections and vice versa.

Geographical coordinates

Geographical coordinates specify a location on the ball-shaped earth by degrees. The
latitude is the number of degrees north of the equator for locations in the Northern
hemisphere, or south of the equator for locations in the Southern hemisphere. The
longitude is the number of degrees east of the prime meridian (Greenwich, UK) for the
Eastern hemisphere, or west from Greenwich for the Western hemisphere.

In The Land Use Database, geographical coordinates can be entered in decimals or in
degrees, minutes and seconds (in the hexadecimal system: [T). This is selected in the
Settings screen, see Section 6.2.1.

UTM (Universal Transverse Mercator Grid System) Projections

The UTM (cylindrical) projection transforms small parts of the earth's surface (UTM zones)
into flat rectangles in order to facilitate topographic mapping, since it shows equal distances.
Within the UTM zone, the location is specified by its Northing and Easting, expressed in
meters. Latitudes from 800 to 84 [N are covered by the system.

Ellipsoid and spheroid specifications are used to carry out the transformations required for
UTM projections. These depend on the local shape of the earth, and are therefore often
location-specific. A number of ellipsoids and spheroids developed for different parts of the
world can be used in The Land Use Database. Ellipsoids and spheroids must be selected in
the settings screen (Section 6.2.2). Since ellipsoids and spheroids differ widely, it is very
important to select the right one when entering UTM coordinates in The Land Use Database,
i.e. the one used for the coordination system of the information source (map, satellite image,
report, etc.) from where the coordinates were obtained.

Note

Since The Land Use Database stores all coordinates as geographic coordinates, UTM
projections will be converted before storage. Due to the complexity of these conversions,
the UTM projections may be slightly different after storage.




Appendix 5.

Maximum and Minimum Data Entry Filter

Three standard data entry filters are provided with The Land Use Database. In the
Maximum Filter, all possible fields are selected and for a number of fields glossary
items are pre-selected, especially for data unit fields. In the Minimum Filter, no fields
are selected, so data entry screens will only contain the fields that are always
included (‘Fix’ fields); for some fields, glossary items are pre-selected, especially
for the fields with data units. The Minimum Filter t Periods, the Minimum Dataset is extended
with fields containing temporal aspects of the land use data, e.g. operation
sequence period, task time.

Below, the Maximum and Minimum Filters are printed showing the selected

parameters and pre-selected parameter values.

Maximum Filter

Fix = Compulsory Field
Yes = Sdected Fied

<> o Comments

»

= Not Specified

>>- = Not Further Specified

Context Classif.

='A-PRIORI LAND USE CLASSES

Oper.Seq.Classifiers  Yes»

Yes»

= and USE DATA

Project
Enumeration Date
Enumerator's Name
Respondent's Name
Holder's Name
Holding Lat-Long

Holding Size
- Unit

- Info Source
Comments

Mapping Unit-1D

1. DARE IDENTIFICATIONS
Administrative Area Fix »

Holding UTH Coord.

Fix »

Yes

Yes Display Previous Entry: Yes
Yes Display Previous Entry: Yes
Yes Display Previous Entry: Yes
Yes

Yes

Yes

Yes Areas (Square Heasures), >>-
Yes»

Yes

). STE IDENTIFICATIONS

- Comp./Element-ID

Yes Display Previous Entry: Yes
Yes




- IY&ap Comments
Si Name
Calastral Number

parcel Size
- Unit

- Info Source
- Unit

- Info Source
Conments

-3, LAND USE SYSTEM DESCRIPTIONS

Yes
Yes
Yes

Tenancy Arrangement Yes »

Yes
Yes Areas (Square Measures), » -
Yes»

Distance to Holding Yes

Yes Time (Duration), »-

Lengths (Linear Measures), »-
Yes>»
Yes

Plot Lat-Long Yes
Plot UTM Coord. Yes
Plot Size Yes
- Unit Yes Areas (Square Measures), >
- Info Source Yes»
Infrastructure Yes»
Quantity Yes
- Unit Yes No Dimension (Just Numbers), »-
Lengths (Linear Measures), »-
Areas (Square Measures), »-
Volumes (Cubic Measures), »-
Percentages (%), » -
- Info Source Yes»
Soil Sample-ID Yes
oper.Seq. Period Yes
a-Priori LU Class Fix »
Species/Service Fix < A-Priori Land Use Class acts as Filter »
Quantity Fix
- Unit Fix No Dimension (Just Numbers), »-
Percentages (%), » -
Areas (Square Measures), »-
- Info Source Yes»

Product/Benef it

Fix <A-Priori Land Use Class acts as Filter »

Quantity Fix

- Unit Fix No Dimension (Just Numbers), »-
Volumes (Cubic Measures), »-
Masses (Weights), »-
Rates,Yield (Weight/Areaq), »-
Rates,Yield (Volume/Aregq), »-
Rates;FHow (Volume/Time), »-

- Info Source Yes »

Comments Yes




4 .OPERATIONS:

Operation Name

$ of Plot involved
Operation Period
Periodicity

- Description
operation Duration
= Unit

Fix »

Yes

Yes

Yes

Yes

Yes

Yes Time (Duration), Hour, » -
Time (Duration), Day, » -
Time (Duration), Week, »-
Time (Duration), Month, »-

- Info Source Yes»
Tak Time Yes
Unit Yes Percentages (%), » -
Time (Duration), Manday, >-
Info Source Yes»
Labour Inputs
Gender »Age Class Fix »
Skill Yes»
No. of Persons Yes
- Info Source Yes»
Task Time Yes
- Unit Yes Percentages (%), » -
Time (Duration), Manday, » -
- Info Source Yes»
Labour Origin Yes»
Haterid Input Fix »
Qudity Class Yes »
Quantity Fix
- Unit Fix No Dimension (Just Numbers), »-
Lengths (Linear Measures), »-
Volumes (Cubic Measures), »-
Masses (Weights), »-
Rates)Yield (Weight/Area), »-
Rates,Yield (Volume/Areq), » -
- Info Source Yes »
[nput Origin Yes »
Implement Yes>»
Qudity Class Yes»
Number used Yes
- Info Source Yes»
Implement Origin~ Yes»
Main Power Source Fix »

Products/Benef its

Quality Class
Quantity

- Unit

- Info Source

Fix ¢ A-Priori Land Use Class acts as Filter »
Yes»

Fix

Fix < Linked to Land Use System Description »
Yes»




Minimum

Product Destination Yes >>

- A-Priori LU Class < See Filter Setting under Land Use Data >

Comments Yes

1. OBSERVATIONS

Observation Name Fix »

SanpleID Yes

Observation Period  Yes

Relocated Materid  Yes Plant Produce, » -
Anima Produce, >> -
Sail, >> -
Water, » -
Mineral/Nutrients, >> -

- Origin/Destination Yes »

Obsarved Quantity Yes

- Unit Yes No Dimension (Just Numbers), »-
Percentages (%), » -
Volumes (Cubic Measures), » -
Masses (Weights), »-
Rates,Yield (Weight/Area), »-
Rates,Yield (Volume/Area), »-
Rates; Flow (Volume/Time), »-

- Info Source Yes »

Implements Used ~ Yes< See Under Operations>

Production Increase Yes

- Info Source Yes >>
Comments Yes
Filter

Fix = Compulsory Field
Yes = Sdected Fidd

< > = Comments

>> = Ungpecified

>>- = Further Unspecified

=A-PRIORI LAND USE CLASSES=

Oper.Seq.Classifiers Yes >>
Context Classif. Yes»

—=LAND USE DATA

—1.DATASET IDENTIFICATIONS




Project

Administrative Area Fix »

Fix »

—29TE IDENTIFICATIONS
H3LAND USE SYSTEM DESCRIPTIONS

A-Priori LU Class Fix »
Specied/Service Fix < A-Priori Land Use Class acts as Filter >
Quantity Fix
- Unit Fix No Dimension (Just Numbers), »-
Percentages (%), » -
Areas (Square Measures), »-
Product/Benefit Fix < A-Priori Land Use Class acts as Filter >
Quantity Fix
- Unit Fix No Dimension (Just Numbers), » -
Volumes (Cubic Measures), » -
Masses (Weights), » -
Rates,Yield (Weight/Areq), »-
Rates,Yield (Volume/Ared), » -
Rates;Flow (Volume/Time), » -

4 OPERATIONS
Operation Name

Fix »

—Labour Inputs

Gender & Age Class Fix »

Materia Input Fix »

Quantity Fix

- Unit Fix No Dimension (Just Numbers), »-
Lengths (Linear Measures), >
Volumes (Cubic Measures), »-
Masses (Weights), »-
Raes Yidd (Weight/Area), » -
Rates;Yield (Volume/Area), » -

Main Power Source Fix »

Products/Benefits Fix < A-Priori Land Use Class acts as Filter >

Quantity Fix

- Unit Fix < Linked to Land Use System Description »

-, OBSERVATIONS
Obszrvation Name

Fix »




- The Land Use
[1atabase

Appendix 6. Structure of Query Output
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If you wish to retrieve large amounts of information from different files of The Land Use
Database to a flat query output file, the information of different files is structured in the
following way:

DI

0

LUS

Infr

Obs

Impl

@)
©
®

Impl

Mat

P/B

Lab

S = N N T = W Sy

[ S

-

-
-

e e S o Y =Yy W
e e S o Y =Yy W

-
-

[
[

-
=

N [P P PR R R R

N R e

w N
AW PN

DI

Sl
LUSD
Infr
LUP
Obs
Impl
Oper
Impl
P/B
Mat

Dataset Identifications
Site Identifications

Numbers refer to information from a record
Dots (...) refer to a similar structure as above

Land Use System Descriptions

Infrastructure

Land Use Purposes

Observations

Implements Used

Operations

Implements Used

Products/Benefits Obtained

Material Inputs
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Appendix 7. Specifying Qualitative Periods

Often periods of time, e.g. of an operation sequence, cannot be given accurately by the
respondent. In these cases, the following rules may be used to transform ‘qualitative’
periods into start and end dates that can be entered in the applicable fields of edit screens.

Qualitative period Start date End date
Dates on a weekly basis

First week of May 1991 01/05/91 07/05/91

Second week of May 1991 08/05/91 14/05/91

Third week of May 1991 15/05/91 21/05/91

Fourth week of May 1991 22/05/91 31/05/91
Dates by 10-day periods

Beginning of May 1991 01/05/91 10/05/91

Mid of May 1991 11/05/91 20/05/91

End of May 1991 21/05/91 31/05/91
Dates by 15-day periods

First half of May 1991 01/05/91 15/05/91

Second half of May 1991 16/05/91 31/05/91
Dates on a monthly basis

During May 1991 01/05/91 31/05/91
Dates on a 3-monthly basis

First quarter of 1991 01/01/91 31/03/91

Second quarter of 1991 01/04/91 30/06/91

Third quarter of 1991 01/07/91 30/09/91

Fourth quarter of 1991 01/10/91 31/12/91
Dates on a 4-monthly basis

Beginning of 1991 01/01/91 30/04/91

Mid of 1991 01/05/91 31/08/91

End of 1991 01/09/91 31/12/91
Dates on a 6-monthly basis

First half of 1991 01/01/91 30/06/91

Second half of 1991 01/07/91 31/12/91

Dates on a yearly basis
During 1991 01/01/91 31/12/91
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Appendix 8. Operator and Function Codes to Build Formulas

Formulas (expressions) are used to combine or calculate values. They can include built-in
functions. Expressions can be constructed by any of the following operators:

Operator Description Data Type

0 grouping all

+ concatenate characters, memos
- concatenate, but put interven. characters, memos

spaces behind string

- subtract date
+ addition / unary positive numbers
- subtraction / unary negative numbers
* multiplication numbers
/ division (with remainder) numbers
% modulus (remainder of numbers
division)
** A power numbers
< less than relative
<= less than or equal relative
> greater than relative
>= greater than or equal relative
= equal relative
== exactly equal (characters only) relative
< #, 1= not equal relative
$ contained in (characters only) relative
AND. all must be true logical
.OR. one of all must be true logical
.NOT., ! unary negate logical
.T. true (not operator, but value) logical
F. false (not operator, but value) logical

A number of pre-defined functions are built-in. Just an extract of functions is given below.
Additional functions can be found in any Clipper manualJNa"cket,

Note: c are character strings/memos, n are numbers, d are dates, and | are logics.

Functions returning a number

ASC(c) Returns the ASCII-value of the first character in c. Opposite of CHR.

AT(cl, c2) Returns the position of c1 in c2, or 0 if c2 does not contain c1.

EXP(n) Returns the exponent of n, which is approximately 2.7181 raised to the
power n. The maximum value of n is 45. Opposite of LOG.

INT( n) Returns the integer part of n. All the decimals are truncated, not rounded.
See also ROUND.

LEN( c) Returns the number of characters contained in c.

LOG( n) Returns the natural logarithm of n. n Must be greater than 0. Opposite of
EXP.

MAX( n1, n2) Returns the maximum value of n1 and n2.

MIN( n1, n2) Returns the minimum value of n1 and n2.

ROUND( n1, n2) Returns n1, rounded to n2 decimals.
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Functions returning a character string

ALLTRIM( c)
CHR(n)
DTOC( d)
FIRSTCAP( c)

LEFT(c, n)
LOWER( ¢)

LTRIM( c)
REPLICATE(c, n)
RIGHT(c, n)
SUBSTR( ¢, n1, n2)

UPPER( c)

Returns c, in which all leading and trailing blanks are stripped.

Returns the character which has the ASCIl-value n. Opposite of ASC.
Returns a character string containing the date d. It will be in the format of
the date setting. Opposite of CTOD.

Returns c, in which all words start with an upper-case letter and the rest
of the word in lower-case. See also LOWER and UPPER.

Returns the first n characters of c.

Returns c, in which all characters are converted to lower-case. See also
FIRSTCAP and UPPER.

Returns c, in which all leading blanks are stripped. See also ALLTRIM,
TRIM and RTRIM.

Returns a character string which contains n repetitions of c.

Returns the last n characters of c.

Returns n2 characters from c, starting at the character at position n1. If
n2 is omitted, returns all the characters from c starting at position nl.
Returns c, in which all characters are converted to upper-case. See also
FIRSTCAP and LOWER.

Functions returning a logic value

.F.
.T.

Functions returning a date
CTOD( c)

DATE()
MAX( d1, d2)
MIN( d1, d2)

Miscellaneous functions
IF(1, X, y)

Returns false.
Returns true.

Returns the date, contained in c. ¢ Must represent the date according to
the date setting. Opposite of DTOC.

Returns the system date.

Returns the latest date of d1 and d2.

Returns the first date of d1 and d2.

Evaluates the logic condition I. If that is true, evaluates and returns
expression x, else expression y. x And y may be of different type.
Examples: IF( .T., 3, 5) returns 3. IF( 3>5, 3*5, 3*4) returns 12.
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Appendix 9. Print of an Example Dataset

A print-out of a complete dataset, as collected in Botswana during the fieldtest of The Land
Use Database and stored in the program, is shown below:

DATASET IDENTIFICATIONS
Date: 18/12/1995 Time: 16:41:00

==1. Dataset Identification==

Administrative Area

Project

Dataset Number
Dataset Type
Enumeration Date
Enumerator's Name
Respondent's Name

Africa, Botswana, Central, Palapye, Ratholo,
Mokgalwana

FAO, BOT/91/001

21

Actual

12/11/1993 (dd/mml/yyyy)

Moahi T S

Moshoeshoe Moshoeshe

==2. Site ldentifications

Plot Aggregation

==3. Land Use System Descriptions ===

Each LUS Description is valid for one Plot

Plot Location - Geographic Coordinates

- Latitude (ory) : South:
- Longitude ( or x): East:

Plot Location - UTM Projection

- Ellipsoid/Spheroid
-UTM Zone

- Northing

- Easting

Plot Size

- Unit

- Info Source

- Boundaries

22°44'41" [Degrees] ( 22.74472)
27°32'17" [Degrees] ( 27.53806)

Clarke 1880
35
: 7484850 [Meters]
555246 [Meters]
1.00 - 1.00 [Min - Max]
Hectare (ha) (10000.0000000000)
Collected in the Plot, through Interview, of Farmer
Based on actual Plot Boundaries

==Infrastructures ===
Infrastructure :

Infrastructure

Plot Structures / Works, Fences, made of Combined
Materials
Roads and Paths, >> -

Oper.Seq. Period
A-Priori LU Class

- Species/Service
Product/Benefit
- Quantity

- Unit
- Info Source

24/01/1993 - **/11/1993 (dd/mm/yyyy)
FAO-Test, Mixed-Intercr.of Cereal +
Pukin/Melons/Pulse/Sw.Reed

Plants, Cereals, Sorghum/Broom~/Durra~/Jowar;
Sorghum bicolor (L.) Moench, cv. Segaolane

Plant Produce, Flowers/Fruits/Seeds, Grain (Cereals),
Not Milled/Cleaned

0.00 - 0.00 [Min - Max]

Kilogram (kg) (1.0000000000)

Collected in the Plot, through Interview, of Farmer
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- Species/Service : Plants, Edible fruits and nuts, Other Families,
Watermelons; Citrullus lanatus (Thunberg) Matsum. &
Nakai, Watermelons; ssp. vulgaris (Schrader) Fursa

Product/Benefit : Plant Produce, Flowers/Fruits/Seeds, Fruits

- Quantity : 0.00 - 0.00 [Min - Max]

- Unit : Pieces (1.0000000000)

- Info Source : Collected in the Plot, through Interview, of Farmer

==4. Operations & Observations======

Operation Name : Tillage, Ploughing, Along Contours (or Flat), >> -
Operation Period 24/01/1993 - 31/01/1993 (dd/mm/lyyyy)
Operation Duration : 1.00 - 1.00 [Min - Max]
- Unit : Day (1.0000000000)
- Info Source : Collected in the Plot, through Interview, of Farmer
Task Time : 2.00 - 2.00 [Min - Max]
- Unit : Manday (0.3333333330)
- Info Source : Collected in the Plot, through Interview, of Farmer
==Labour Inputs
Gender & Age Class : Adult 16-59 years, Male, >> -
Labour Origin : Contract Labourer
==Implements Used ====
Implement : Mechanically Powered, Tractors, Four wheel
tractor, Rear-Wheel Drive, >> -
Number used : 1.00 - 1.00 [Min - Max]
- Info Source : Collected in the Plot, through Interview, of
Farmer
Implement Origin : Rented, >> -
Implement : Powered by other Equipment, for Tillage,
Primary Tillage Implements, Ploughs, >> -
Number used : 1.00 - 1.00 [Min - Max]
- Info Source : Collected in the Plot, through Interview, of
Farmer
Implement Origin : Rented, >> -
Main Power Source : Human Power
Operation Name : Fallow Grazing
Operation Period **/04/1993 - **/11/1993 (dd/mm/yyyy)
Operation Duration : 6.00 - 7.00 [Min - Max]
- Unit : Month (30.5000000000)
- Info Source : Collected in the Plot, through Interview, of Farmer
Observation Name Growth Reducing Factors, Infectious Plant

Related, Livestock

Observation Name Crop Conditions, Wilting

*** END OF DATASET IDENTIFICATIONS ***



Appendix 10. Print of an Example A-Priori Land Use
Classif ication System

A print-out of part of the a-priori land use classification system as developed for
fieldtest of The Land Use Database in Southern Africa and stored in the
program, is shown below:

A-PRIORI LARD USE CLASSES
Date: 18/12/1995 Time: 16.51.19

=Code 5: FAO-Test

Code o1
A-Priori LU Class : Single Cropping of Cereds
-Land Use Purpose Classifiers
- SpeciedService : Plants, Cereals, » -

Product/Benefit  : Plant Produce, Vegetative parts, »-
- SpeciesdService  : Plants, Cereals, » -

Product/Benef it . Plant Produce, Flowers/FruitsSeeds, Grain (Cereals), » -
-Operation Sequence Classifiers
-1 : Crop Production, Yes, Temporary (arable) Cropping, Single Cropping, »-

Code C2
A-Priori LU Class Sequentlal Double Cropping of Cereals-Cereds
-Land Use Purpose Classfiers
- SpeciedSarvice  : Plants, Cereals, »-

Product/Benef it : Plant Produce, Vegetative parts, >-
- Species /Service  : Plants, Cereals, » -

Product/Benefit  : Plant Produce, Flowerg/FruitySeeds, Grain (Cereds), » -
-Operation Sequence Classifiers
-1 : Crop Production, Yes, Temporary (arable) Cropping, Multiple Cropping, Sequential Cropping (-),

Double

Code 3
A-Priori LU Class Sequentiadl Double Cropping Cereals-Vegetables
-Land Use Purpose Classifiers
- SpeciegService : Plants, Cereals, » -
Product/Benefit  : Plant Produce, Vegetative parts, » -
- SpeciegService : Plants, Cereals, »-
Product/Benef it : Plant Produce, Flowers/Fruits/Seeds, Grain (Ceredls), »-
- SpeciesdService : Plants, Vegetables, » -
Product/Benef it : Plant Produce, Vegetative parts, Leaves / Shoots, » -
- SpeciedService : Plants, Vegetables, »-
Product/Benef it : Plant Produce, FlowergFruity/Seeds, » -
-Operatlon Sequence Classfiers
-1 : Crop Production, Yes, Temporary (arable) Cropping, Multiple Cropping, Sequentia Cropping (-),
Double




